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Quick Start 

 

 

The quickest way to get up and running in using PowerStar is to open the sample circuit files provided with the 

installation. These are normally located in the Circuits folder under your documents folder. 

 

 Familiarize yourself with the function of the toolbar buttons by slowly mousing over them, noting the tool 

tips and watching the status bar messages. Do the same with the symbols on the symbols toolbar. 

 

 Open a sample circuit. Mouse over the symbols and note the tool tips and status bar messages. 

 

 If the circuit is not active, click on the calculate button . The meter bar should appear. Mouse over the 

circuit diagram symbols and watch the data tips. Select a symbol and read the meter bar panels and status bar. 

 

 Try moving individual lines and symbols by left clicking on them and dragging them to different screen 

positions. Try copying them by holding down the [Ctrl] key and dragging the symbols or lines to another 

position. 

 

 Add a new symbol by selecting a symbol from the symbols toolbar and clicking on an empty area on the 

screen. 

 

 Add a new line by mousing over a snap grid position until the cursor turns to crosshair. Left click and drag 

the cursor to the desired end point. 

 

 Double click on a circuit diagram symbol to bring up the device properties pages. Modify the device data, 

calculate the circuit and observe the effect on the electrical data. 

 

If you encounter any difficulties doing any of the above, please refer to the appropriate section of this help file. 
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Using PowerStar 

 

 

The use of PowerStar consists of three basic steps: 

1. Drawing the circuit diagram. 

2. Entering data for all devices in the diagram. 

3. Calculating the circuit. 

 

Drawing the Circuit Diagram. 

 

The circuit can be any actual circuit consisting of standard electrical devices and equipment such as cables, 

loads, generators, motors, etc. The circuit is represented by drawing symbols and connecting lines on the screen 

circuit display area. The result is a single line diagram. 

To draw a symbol, click on a symbol button on the symbols bar. Move the mouse cursor to the desired position 

on the screen and click to draw the symbol. 

Connecting lines are started by positioning the mouse cursor on a grid point where it turns into a crosshair 

cursor.Click and hold the left mouse button and move to the desired endpoint. Note that lines may only be 

drawn between snap grid points. Snap grids may be displayed by clicking on the Snap Grid Button . 

Connecting lines may only be drawn as vertical or horizontal lines.When crossing over other lines, the line 

being drawn automatically crosses over (no connection) the other line. To cross-connect, terminate the line on 

the connection point. 

 

Entering Data. 

 

Data for all the symbols must be entered before circuit analysis may be performed. To enter data for a device, 

double click on the symbol. This will activate a Data Entry Form. Most of the data entry fields in this form are 

required, although some, such as the Label and Description fields are not. 

A helpful feature of PowerStar is the Device Database. By clicking on the [DATABASE] button in the Data 

Entry Form, a Database List Box is activated. By clicking on menu drop down lists and selecting from the main 

list, the data entry fields on the Data Entry Form are automatically filled in. Of course, some fields such as 

cable lengths must still be filled in manually. 

Another helpful feature is the [AUTOFILL] button. Clicking on this button will automatically fill in the data 

entry fields with values used in the last form edited.  

 

Calculation. 

 

Calculation is started by selecting CIRCUIT|CALCULATE from the menu or clicking on the Calculate Button 

 on the Circuit Toolbar. This will start the analysis and error checking process. 

When the calculation is completed, the meter bar is displayed. Mouse-over any symbol to show voltages, 

current kva, kw and power factor on the meter toolbar.  
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Keyboard Shortcuts 

 

 

Following are tables of keyboard shortcuts. Many of the shortcuts can speed up PowerStar operations like 

zooming the circuit display. 

 

Edit Operations 

Menu  Keyboard  Action 

Copy  Ctrl+C   Copy object to clipboard 

Cut  Ctrl+X   Delete object and save to clipboard 

Paste  Ctrl+V   Paste object from clipboard 

Undo  Alt+BkSp  Reverse the last operation 

 

Common Operations 

Menu   Keyboard Action 

Circuit|Report  Ctrl+R  View circuit report 

Circuit|Calculate F8  Calculate circuit. 

Device|Data  Enter  Show device data 

View|Grid  Ctrl+G  Toggle Grid display 

Help   F1  Display help 

Close Window  Alt+F4  Close current window 

 

Zoom Operations 

View Command Keyboard  Action 

Zoom In  [ + ]  Increase magnification 

Zoom Out  [ - ]  Decrease magnification 

Z 
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Mouse Techniques 

 

In addition to the standard functions of the mouse in Windows, there are several additional functions of the 

mouse in PowerStar. 

 

Device Information - Mouse over a symbol to display a tool tip with device information such as label, name, 

device class, connection. Clicking on a symbol will display device information on the Status Bar. A double 

click on the symbol activates a Device Information Box that displays more detailed information on the device.  

 

Entering or Editing Device Data - If the circuit is inactive (has not been calculated or has just been edited), a 

double click on the symbol activates a Data Entry Form for filling in or editing device ratings.  

 

Drawing Symbols - Click on a symbol button on the symbols toolbar to select the symbol. Move the cursor to 

the desired position on the screen. Note that the cursor changes to indicate the final symbol position. Left click 

to add the symbol to the circuit. 

 

Drawing Connecting Lines - Clicking on a snap grid position and dragging the mouse cursor across the screen 

produces a rubber banding line. Releasing the mouse button draws a connecting line.  

 

Selecting symbols and lines - Clicking on a symbol will select that symbol indicated by a light grey rectangle 

enclosing the symbol. Clicking on a line will select that line indicated by small black rectangular grab handles 

on both ends. Holding the shift key lets you select select multiple symbols, lines and graphics objects. 

 

Marking a Block - A selection box may be started by clicking anywhere away from snap grid positions. 

Dragging the mouse across produces a rubber banding selection box. Releasing the mouse button will select all 

the symbols, connecting lines and graphics objects previously enclosed by the selection box.. 

 

Moving symbols and lines - Clicking on any selected symbol, line or graphics object and dragging the mouse 

cursor across the screen before releasing the mouse button will move all the selected symbols, lines and 

graphics objects to the new position. Note that symbols may not be moved to a position that is already occupied 

by another symbol or line. 

 

Duplicating symbols and lines - Pressing the [CONTROL] key while clicking on any selected symbol, line or 

graphics object and dragging the mouse cursor across the screen before releasing the mouse button will 

copy  all the selected symbols, lines and graphics objects  to the new position. Note that symbols may not be 

copied to a position that is already occupied by another symbol or line. 
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File menu commands 

 

 

The File menu offers the following commands: 

New Creates a new document. 

Open Opens an existing document. 

Close Closes an opened document. 

Save Saves an opened document using the same file name. 

Save As Saves an opened document to a specified file name. 

Print Prints a document. 

Print Preview Displays the document on the screen as it would appear printed. 

Print Setup Selects a printer and printer connection. 

Send... Sends the active document through electronic mail. 

Exit Exits PowerStar. 

 

 



 

Edit menu commands 

 

 

The Edit menu offers the following commands: 

Undo Reverse previous editing operation. 

Cut Deletes data from the document and moves it to the clipboard. 

Copy Copies data from the document to the clipboard. 

Paste Pastes data from the clipboard into the document. 

Delete Pastes from the clipboard a link to data in another application. 

Select All Selects all connecting lines, symbols and graphics. 

Default Settings Opens settings box for PowerStar default settings. 

 

 



 

View menu commands 

 

 

The View menu offers the following commands: 

Symbols 

Bar 

Shows or hides the toolbar. 

Status 

Bar 

Shows or hides the status bar. 

Grid Shows or hides the screen grid. 

Zoom In Increase screen magnification. 

Zoom 

Out 

Decrease screen magnification. 

Toolbar

s 

Shows or hides devices, graphics and meter toolbars 



 

Circuit menu commands 

 

The Circuit menu offers the following commands: 

Report Generates a text report for this circuit. 

Symbol Set Select a symbol set file. 

Properties Opens a circuit properties dialog box. 

Calculate Calculates the electrical circuit. 

 

 



 

Device menu commands 

 

The Device menu offers the following commands: 

Disconnect Connects/Disconnects the selected device. 

Direction Rotate clockwise, counterclockwise or invert symbol. 

Properties Opens device properties settings box. 

 

 



 

Graphics menu commands 

 

The Graphics menu offers the following commands: 

Select Use selection tool. 

Line Draw line tool. 

Rectangle Draw rectangle tool. 

Round 

Rectangle 

Draw rounded rectangle tool. 

Ellipse Draw ellipse tool. 

Pie Draw elliptical pie tool. 

Arc Draw elliptical arc tool. 

Chord Draw elliptical chord tool. 

Polygon Draw polygon tool. 

Polyline Draw polyline tool. 

Text Draw text tool. 

Arrange Group/un-group selections. Move selected graphics layer forward/backward. 

 

 



 

Help menu commands 

 

 

The Help menu offers the following commands, which provide you assistance with this application:  

Help 
Contents 

Opens the help viewer on the contents table. 

Help Index Offers you an index to topics on which you can get help. 

Buy Now Opens the default internet browser to the PowerStar products page. 

Enter 

License Key 

Opens an entry form for the activation key. 

About Displays the version number of this application. 

 

 



 

Window menu commands 

 

 

The Window menu offers the following commands, which enable you to arrange multiple views of multiple 

documents in the application window: 

New Window Creates a new window that views the same document. 

Cascade Arranges windows in an overlapped fashion. 

Tile Arranges windows in non-overlapped tiles. 

Arrange Icons Arranges icons of closed windows. 

 

 



 

Toolbars 

Use this command for instructions about using Help. 



 

Main Toolbar 

 
 

 

 New File - create a new circuit file. 

 

 Open  File - open an existing circuit file. 

 

 File Save - save the current circuit file. 

 

 Edit Cut - cut the selected object and save to Windows clipboard. 

 

 Edit Copy - copy the selected object and save to Windows clipboard. 

 

 Edit Paste - copy the saved object in Windows clipboard to the current circuit. 

 

 File Print - print the current circuit diagram. 

 

 Help About - display PowerStar copyright and version information. 
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Circuit Toolbar 

 
 

 

 Snap grids - show/hide snap grid points. 

 

 Zoom In - increase screen magnification. 

 

 Zoom out - decrease screen magnification. 

 

 Graphics - show/hide graphics toolbar. 

 

 Next symbols - display next group of symbols on the toolbar. 

 

 Symbols - show/hide symbols toolbar. 

 

 Previous symbols - display previous group of symbols. 

 

 Rotate clockwise - rotate selected symbol clockwise. 

 

 Rotate counter-clockwise - rotate selected symbol counter-clockwise. 

 

 Invert - invert selected symbol head-tail. 

 

 Line connection - connect/disconnect individual lines and neutral. 

 

 Disconnect - disconnect the selected device from the circuit. 

 

 Calculate - show/hide electrical data/load flow for the circuit. 

 

 Meter bar - show/hide meter bar. 
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Graphics Toolbar 

 
 

 

 Selection tool 

 

 Line  

 

 Rectangle 

 

 Rounded rectangle 

 

 Ellipse 

 

 Elliptical Arc 

 

 Elliptical Pie 

 

 Elliptic chord 

 

 Filled polygon 

 

 Polyline 

 

 Text 

 

 Move selection forward 

 

 Move selection backward 

 

 Move selection to front 

 

 Move selection to back 

 

 Group selection 

 

 Un-group selection 
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Circuits 

 

 

Circuit as used in PowerStar is a single line diagram representing a physical circuit. The represented circuit may 

be a combination of balanced or unbalanced three phase or single phase devices. There must be one source 

(either a generator or a source bus), and one or more passive device (say, a load or a cable). 

All branches should preferably be terminated through a load , although PowerStar will still correctly analyze 

the circuit as long as some of the branches are correctly terminated. 

All devices in the circuit must be interconnected into one circuit, either through other devices or through 

connecting lines. Two or more independent (not interconnected) circuits are not allowed. 

 
Example of a circuit 
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Devices 

 

 

Device as used in PowerStar means any electrical equipment, circuit element or component. The device is 

represented in the circuit as a symbol. The device may be balanced or unbalanced, linear, passive or active and 

must not be coupled either capacitively or inductively with other devices in the circuit. The symbol may be 

single-ended (3 terminals for three phase) or double ended(6 terminals) excluding the neutral.  

 

All devices have three optional properties, name, label and description . The label and name may optionally be 

shown on the screen and on the circuit printout.  

 

Devices are classified as follows: 

 

 CONNECTION DEVICE 

 IMPEDANCE 

 CABLE 

 TRANSFORMER 

 GENERATOR 

 SYNCHRONOUS MOTOR 

 INDUCTION MOTOR 

 LOAD 

 SOURCE BUS 

 POWER CAPACITOR 

 POWER REACTOR 

 DISTRIBUTION BOARD 

 PANELBOARD 

 MOTOR CONTROL CENTER 

 PROTECTIVE DEVICE 

 NULL DEVCE 
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Symbols 

 

 

A symbol drawn on the screen is a graphical representation of a Device. A symbol has the following properties. 

 

Device Class - indicates the classification of the device represented. 

 

Connection - Whether the symbol is connected to the circuit on its head or head-tail. The connection is 

basically determined by the device class, for example, head-tail for cables and transformers and head only for 

motors, generators and loads. 

 

Label - A symbol has a label that is shown below and to the right of the symbol on the circuit display. This is 

also shown on the Status Line. When first inserted in the circuit, the label is only a pre-set prefix (such as "T" 

for a transformer). When you start the calculation process, PowerStar automatically numbers the symbols if the 

device auto-number option flag is checked. The numbering sequence is left to right, top to bottom. For 

example, the top leftmost transformer label will now be "T1". The device label can be positioned by clicking on 

the label and dragging it to the desired position . 

 

Position and Orientation - The symbol head is positioned on a snap grid point. It can be rotated around this 

point using the rotate buttons   or inverted using the invert button  . 
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Grids and Lines 

 

 

Grids - All connecting lines and device symbols are drawn between snap grids. The position of these grids may 

be shown or hidden by toggling the Snap Grid Button . 

 

Lines - Connecting lines are drawn by dragging the mouse cursor across the screen while pressing the mouse 

left button. The line must be started by pressing the left mouse button on a snap grid position.   
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Abbreviations 

 

 

I - Current, amps 

Ipri - Current, Primary Winding 

Isec - Current, Secondary Winding 

I1 - Current at device head 

I2 - Current at device tail 

Ia, Ib, Ic - Line current 

Irated - Rated Current 

Ist/Ifl - Starting to Full Load Current Ratio 

kA - Current, amps X 1000 

 

kAsc - Short Circuit Current X 1000 amps 

kW - kilowatt 

kVA - kilo-voltamps 

kVAr - kilo-voltamps reactive 

MVAsc - Short Circuit MVA 

 

R - resistance, ohms 

R/km - unit resistance 

 

V1 - voltage at device head 

V2 - voltage at device tail 

Vd - voltage drop, volts 

Vpri - voltage, primary winding  

Vsec - voltage, secondary winding 

Van, Vbn, Vcn - Line to neutral voltage 

Vab, Vbc, Vca - Line to line voltage 

 

% Load - loading in percent 

% R - Percent resistance referred to device base impedance 

% Tap - percent tap referred to nominal secondary voltage. 

% VR - Voltage regulation in percent 

 

% X - percent reactance referred to device base impedance 

% Xs - percent synchronous reactance referred to device base impedance 

 

X - Reactance, ohms 

X/km - unit reactance, ohms per kilometre 

X/kft - unit reactance, ohms per kilofeet 

 

P.F. - power factor 

Sets - number of conductor sets in parallel 
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Using the symbols toolbar 

 
 

 

Use the symbols button  to show or hide the symbols toolbar. The next symbols group button  and 

previous symbol group button  selects the symbol group to display on the symbols toolbar. 

 

Mouse over any of the symbols on the toolbar to display the device class or type on the status bar. 

 

Select a symbol by clicking on a symbol button, then move the mouse to the desired grid location on the screen. 

Note that the cursor shape changes to indicate the symbol orientation depending on the position of the cursor 

relative to the snap grid point. Left click the mouse button to add the symbol to the circuit diagram. 
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Manipulating the symbols 

 

 

To move a symbol on the screen simply click on the symbol and drag it to the new position while holding the 

left mouse button. Release the button to position the symbol on the closest snap grid point. 

 

To move a group of symbols, connecting lines and graphics objects, select the group. Left click and hold the 

mouse button on the upper left corner of the desired area. Drag the cursor across until the rubber-banding 

square encloses the symbols to be selected. Release the mouse button to select all the symbols, connecting lines 

and graphics inside the selection area. Alternatively, select a group of symbols by holding the [SHIFT] key 

while clicking on the symbols to be selected in turn. 

 

Next, left click on any selected object and drag the mouse cursor across the screen until the symbols are 

positioned over the desired area. Release the mouse button. 

 

Each symbol can be individually rotated around its head point using the clockwise button  or the 

counter-clockwise button  . It can also be inverted head to tail using the invert button  . 
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Drawing connecting lines 

 

 

To draw connecting lines, position the mouse cursor over a snap grid point. The mouse cursor will turn to 

crosshair when positioned properly over a snap grid point.To show the grid points, click on the snap grid button 

 on the Circuit Toolbar. 

 

Press and hold the left mouse button and drag the cursor across the screen. A rubber banding line will show 

where the line will be drawn. Release the mouse button when the desired direction and length of the line are 

shown. 

When adding new connecting lines, the lines will automatically cross over intersected lines without connecting 

to those lines. 
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Copying and pasting symbols and blocks of symbols 

 

 

To duplicate a device, press and hold the [Ctrl] key, left click the center of the symbol and drag the cursor to the 

desired position before releasing the mouse button. 

To duplicate a block of symbols, the symbols must first be selected. To do this, click and hold the mouse button 

on the upper left corner of the desired area. Drag the cursor to the opposite corner until the desired block size is 

shown. Releasing the mouse button will select all the symbols, connecting lines and graphics inside the 

selection area. Multiple symbols may also be selected by holding the [SHIFT] button while clicking on each 

symbol to be selected in turn. 

 

Next, press and hold the [Ctrl] key, left click on any selected object and drag the mouse cursor across the screen 

until the symbols are positioned over the desired area. Release the mouse button. 

 

Note that when copying or duplicating symbols or blocks of symbols, the device attributes, including the device 

data are copied over to the new symbols. 

 

To copy the selected symbols, lines and graphics objects to Windows clipboard, click on the Copy Button on 

the main toolbar. or choose Edit|Copy from the menu bar. 

 

Symbols previously saved to Windows clipboard may be pasted in any vacant area on the screen. To start paste 

operation, click on the Paste Button. The cursor changes to a paste cursor. Position the cursor over the insertion 

point (top left corner of the block to be pasted) and click the mouse left button. 

 

Note that the symbol or symbols to be pasted must not overwrite any existing connecting line or symbol. 

Otherwise, the paste operation will fail. 
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Positioning Symbol Labels 

 

To position a symbol label, click on the label and drag the cursor to the desired position before releasing the 

mouse button. Note that the label text may not be modified by double clicking. To edit the symbol label, open 

the symbol properties, select the General tab to edit the text and Options tab to include label, name or data to 

the label. 
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Graphics Elements 

 

Graphics elements do not affect the circuit calculation but are useful for complementing the presentation of the 

circuit diagram. 

 

Graphics elements can be used to:  

 annotate the circuit diagram 

 graphically modify individual symbols 

 add captions 

 create nameplates 

 show borders 

 delineate circuit sections 

 

The following graphical elements are provided: 

 line 

 rectangle 

 rounded rectangle 

 ellipse 

 elliptical arc 

 elliptical pie 

 elliptical chord 

 polygon 

 polyline 

 text 
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Graphics Operations 

 

 

Before creating or manipulating any graphics, click on the  toolbar button to hide the snap grids, unless you 

want the graphics to be sized and located on the snap grid points. 

 

To create a graphics object, select the desired shape from the toolbar buttons, left click on the top left corner 

and drag the cursor to the bottom right to the approximate size. For polygons and polylines, double click the 

last vertex to complete the polyline/polygon. 

 

Graphics objects, like symbols and connecting lines can be moved, deleted, duplicated and used with Windows 

clipboard operations. They can also be sized. To select a graphics object, click on the inside if it is solidly filled 

or on the outline if not. Selecting a graphics object creates grab handles for that object, which can be clicked 

and dragged to resize it. 

 

All graphics objects will be layered such that the newer objects will display on top of older objects. A selected 

object can be moved towards the front or back by using the following toolbar buttons,    . 

 

To select several objects, press and hold the [Shift] key and left click on individual objects. To select objects 

within an area, left click on the top left of the area and drag the rubber banding selection rectangle to the bottom 

right. 

 

Several graphics object can be grouped together as single object. To do this, select the objects as above, then 

click the  toolbar button. To ungroup the objects, click the  button. 
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Graphics Properties 

 

 

Double clicking a graphics object will display one of the following properties box. 

  

   

  

 

The outline can be invisible, solid, dotted, dashed or dot-dash. The fill can be invisible, solid, or hatched. The 

outline and fill can have the same or different colors. Click the colour button to display the colour selection 

dialog box. 

For text graphics, click on the [Font] button to display the font selection box. 

For elliptical graphics, zero degrees is +x axis (3:00 o'clock), positive is counter-clockwise. The graphics starts 

at the start angle and moves counter-clockwise towards the end angle. 

For rounded corner rectangles, the X and Y axis roundness refers to the relevant radii of the ellipse quadrant 

used to form the rounded corners of the rectangle. 
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Device General Info 

 

Double click on a symbol or select Device Properties from the menu. Select the general tab to display the 

following dialog box. 

 
 

Device Name - Optional. Can be displayed next to symbol. 

Label - Optional. Can be displayed next to symbol. 

Description - Optional. Included in circuit report. 

Connection [ABC-Neutral] - Phase connection of device, must be compatible with upstream connection. 

Double line to neutral not allowed. 

Device is disconnected - When checked, this device is not included in circuit calculation (open circuited). 

Downstream connection also disconnected. 
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Device Database 

 

 

 

 
 

The device database can be used to fill in the device data entry form with typical values. Click [Copy Data] 

button to fill the form with values from the database. 

 

Copy Text - Check this to copy the data record type into the device description field. 

List Device- Create a new device record using the device data values. Record type will be "New Data Record". 

Edit Type- Edit the data record Type/Size field. 

Delete - Delete the selected data record. This action can not be undone. 

Copy Data- Use the record values to fill in the device data. 
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Bus Device Data 

 

 

 
 

Voltage in kV - the no load voltage of this bus source. 

Short circuit MVA - the estimated or calculated short circuit capacity of this bus.  

R/X ratio - the internal resistance to reactance ratio.  

Auto Fill - automatically fill this form using previous values. 

Database - opens the device database of sample bus sources. 
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Cable Device Data 

 

 

 
 

R, ohms/1000 meters - the cable resistance per 1000 meters for each phase. Note that this value is temperature 

dependent. 

X, ohms/1000 meters - the cable reactance per 1000 meters for each phase. The neutral impedance is assumed to 

be zero. 

Length in meters - the cable length. 

Rated current in amps - the rated ampacity of the cable. Note that this dependent on temperature and 

installation configuration. 

Sets in parallel - number of cable sets in parallel. Cable sizes and installation configuration must be identical. 

Auto Fill - automatically fill this form using previous values. 

Metric/Imperial - switch between metric and imperial versions of device database. 

Database - opens the device database of sample cable types. 
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Capacitor Device Data 

 

 

 
 

Voltage in volts - Operating voltage of the capacitor bank/assembly. 

Rated capacity in kVAr - rated kilovar capacity of the capacitor bank/assembly. 

Auto Fill - automatically fill this form using previous values. 

Database - opens the device database of sample capacitors. 
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Distribution Board Device Data 

 

 

 
 

Voltage in volts - Operating voltage of the distribution board. 

Power in kVA - The total load kVA of this board. 

Load P.F. - The net load power factor of this board. 

Panelboard Branch Circuits - the number of branch circuits for this distribution board. 

Override  - Click to manually enter the total load kVA and power factor. 

Auto Fill - automatically fill this form using previous values. 

Details - opens the data entry form for the individual branch circuits. 
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Generator Device Data 

 

 

 
 

Voltage in volts - No-load voltage of the generator. 

Rated capacity in MVA - rated capacity of the generator. 

Voltage Regulation % - the difference between no load and full load voltage divided by full load voltage in 

percent. 

Auto Fill - automatically fill this form using previous values. 

Database - opens the device database of sample capacitors. 
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Impedance Device Data 

 

 

 
 

Resistance, ohms - the actual device resistance in ohms. 

Reactance, ohms - the actual device reactance in ohms. 

Auto Fill - automatically fill this form using previous values. 

Database - opens the device database of sample impedances. 



 

Induction/Synchronous Motor Device Data 

 

 

 
 

Voltage in volts - Operating voltage of the motor. 

Specify load - Select the convenient form for entering the load data. 

Power in kW - Specify the rated power output of this motor. 

Motor P.F. - Enter the actual motor operating power factor. 

Efficiency, per Unit - the mechanical efficiency of the motor. About 80% at 3.75kW(5HP) and 90% at 

37.5(50HP). 

Start-Full Load Ratio - the ratio of starting current to the full loads current. Between 1.5-15, typically 6.5. 

Running/Starting - Select to determine motor current. 

Auto Fill - automatically fill this form using previous values. 

Database - opens the device database of sample motors. 
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Load Device Data 

 

 

 
 

Voltage in volts - Operating voltage of the load. 

Specify load - Select the convenient form for entering the load data. 

Power in kVA - Specify the operating kVA of this load. 

Load Current - Specify the operating current of this load. 

Load P.F. - Enter the load operating power factor. 

Load Resistance - the actual load resistance in ohms. 

Load Reactance - the actual load reactance in ohms. 

Auto Fill - automatically fill this form using previous values. 

Database - opens the device database of sample loads. 
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Motor Control Center 

 

 

 
 

Voltage in volts - Operating voltage of the MCC. 

Power in kVA - The total load kVA of this MCC. 

Load P.F. - The net load power factor of this MCC. 

Motor Control Units - the number of motor control units for this MCC. 

Override - Set to manually enter the total load kVA and power factor. 

Auto Fill - automatically fill this form using previous values. 

Details - opens the data entry form for the individual motor control units. 
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Panelboard 

 

 
 

Voltage in volts - Operating voltage of the panelboard. 

Power in kVA - The total load kVA of this panelboard. 

Load P.F. - The net load power factor of this panelboard. 

Panelboard Branch Circuits - the number of branch circuits for this panelboard. 

Override - Set to manually enter the total load kVA and power factor. 

Auto Fill - automatically fill this form using previous values. 

Details - opens the data entry form for the individual branch circuits. 
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Protective Device Data 

 

 

 
 

Note that all data are optional and not used during calculation. The trip current will indicate if exceeded 

in the calculation. 

Type - Select fuse, air circuit breaker or oil circuit breaker. 

Voltage in kV - rated voltage of the device. 

Trip Current, amps - the current setting of the trip element of the device. 

Interrupting Rating, kA - the maximum current the device can safely break. 

Momentary Rating, kA - the maximum current the device can safely withstand. 

Auto Fill - automatically fill this form using previous values. 

Database - opens the device database of sample protective devices. 
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Transformer Device Data 

 

 

 
 

Pri/Sec - Select primary and secondary winding type. 

Rated Capacity in kVA - Enter transformer capacity in kVA. 

Primary voltage, volts - Operating voltage, primary. 

Primary Tap % - Percentage tap on the primary winding. 

Secondary voltage, volts - Operating voltage, secondary. 

Percent R - Percent of base impedance, resistance. 

Percent X - Percent of base impedance, reactance. 

Auto Fill - automatically fill this form using previous values. 

Database - opens the device database of sample transformers. 
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End User License Agreement 

 

 

PowerStar is a "try-before-you-buy" software product. This means: 

1. All copyrights to PowerStar are exclusively owned by Megasys Software. 

2. Anyone may use this software during an evaluation period of 30 days. If you wish to continue to use 

PowerStar after this period, you must register. 

3. There are 2 basic types of licenses issued for PowerStar, these are: 

a. A single computer USAGE license. The user purchases ONE license to USE PowerStar on ONE computer. 

b. A Multiple USAGE license. The user purchases a number of USAGE licenses for use, by the purchaser, the 

purchaser's employees or accredited agents, on the same number of computers. 

Once registered, the user is granted a non-exclusive license to use PowerStar on as many computers as defined 

by the licensing terms above according to the number of licenses purchased, for any legal purpose. The 

registered PowerStar software may not be rented or leased, but may be permanently transferred, in it's entirety, 

if the person receiving it agrees to the terms of this license. If the software is an update, the transfer must 

include the update and all previous versions. 

4. The license key received after registration of PowerStar may not be distributed. If your license key is found 

to be published anywhere, your license for using PowerStar will be terminated. 

5. The PowerStar unregistered copy, may be freely distributed, with exceptions noted below, provided the 

distribution package is not modified. 

a. No person or company may charge a fee for the distribution of PowerStar without written permission from 

the copyright holder. 

b. The PowerStar unregistered copy may not be bundled or distributed with any other package without written 

permission of the copyright holder. 

c. Hacks/crack, keys or key generators may not be included on the same distribution. 

6. PowerStar is distributed AS IS. No warranty of any kind is expressed or implied. You use this software at 

your own risk. The developer will not be liable for data loss, damages, loss of profits or any other kind of loss 

while using or misusing this software. 

7. You may not use, copy, emulate, clone, lease, sell, modify, decompile, disassemble, otherwise reverse 

engineer, or transfer the licensed program, or any subset of the licensed program, except as provided for in this 

agreement. Any such unauthorized use will result in immediate and automatic termination of this license and 

may result in criminal and/or civil prosecution. 

8. There are NO additional license fees, except the cost of registration, associated with creation and distribution 

of help documents. Legally registered users may use their copies of PowerStar to produce help documents in 

any supported format and to distribute those documents free of any additional royalties related to PowerStar. 

9. Installing and using PowerStar signifies acceptance of these terms and conditions of the license. 

10. If you do not agree with terms of this license you must remove the files of the product from your storage 

devices and cease to use it. 

All rights not expressly granted here are reserved by the copyright holder. 
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How To Order 

 

 

You can order PowerStar online through our secure website.Your payment will be processed by  quite well 

known payment service provider PayPal. You do not need to be a member of PayPal, they will process Visa or 

Mastercard and accept payments in different currencies (US Dollar, Australian Dollar, Euro, Pound Sterling, 

Canadian Dollar, etc). 

Once your order is complete, your license key will be immediately sent via email to unlock the software for 

use. 

The final cost for PowerStar depends on what type of license and how many copies of that license you are 

ordering. The latest pricing information is available on our Web site. 

The quickest way to order is by selecting Help/Buy Now from the PowerStar menu. Or you can simply visit the 

Megasys Software web page and place your order: 

https://www.megasyssoftware.com/products.php 
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License Key 

 

 

As soon as your order for PowerStar is complete, you will receive a license key, which should be entered into 

the program to unlock it for use. 

 

To apply your license key: 

1. Select the license key in your order confirmation e-mail, and press Ctrl+C to copy it to the Clipboard. 

2. Run PowerStar. 

3. Choose Help|Enter License Key from the menu.  

4. In the dialog-box, click the Paste button to insert your license key. 

5. Click the OK button and then restart PowerStar. 

You are strongly advised to save your order confirmation e-mail for future reference. 

Please do not distribute your license key and do not let anybody copy it. Otherwise, as stated in the license 

agreement, if your key is published anywhere, your license for using PowerStar will be terminated. 

Lost your key? 

If, for any reason, you have lost your license key, just contact us and we will resend it to the e-mail address you 

used when registering. 
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Feedback 

 

 

For any questions, comments, or suggestions, please contact our technical support service at: 

support@megasyssoftware.com 

While describing the problems you have found in PowerStar, please provide us with the following information: 

· PowerStar version. 

· Your Windows version. 

· Sequence of your actions that caused the problem. 

· As many details related to the problem as possible. 

Before requesting technical support, please make sure you are using the latest version of PowerStar . 

Information on the latest releases can be found on the Web site at: 

www.megasyssoftware.com 
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Upgrades 

 

 

If you are a legally registered user of PowerStar, you have the right for free upgrades to any newer minor 

version (for example, from 1.0 to any 1.x version). Or, you have the right for free upgrades to any newer major 

version (for example, from 1.x to 2.x, 3.x, 4.x, and so on) in case if the period of one year since your order date 

has not yet elapsed. 

In other cases, you have the right for a 50% discount from our current price for an upgrade to any newer major 

version of PowerStar. 

For more information about recent releases, please visit our Web site at: 

www.megasyssoftware.com 
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